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在互联网形态下,软件产品和服务的深度融合促成了计算机及相关行业的多元化业态

分布,技术分工越来越细,不同层次及不同类型的人才越来越专业,对未来人才的职业素养

(思想品德、行为习惯、思维方式、知识水平和技能水平等)提出了更高的要求。

为深入贯彻党的二十大精神,落实中共中央办公厅、国务院办公厅印发的《关于深化现

代职业教育体系建设改革的意见》,开展职业教育优质教材建设,有效发挥优质专业课程教

材的示范辐射作用,我们对《JavaWeb应用开发》进行了修订。

在修订过程中,我们按照教育部《高等学校课程思政建设指导纲要》的要求,深度挖掘并

提炼课程内容技术体系中所蕴含的思政元素,在全面系统讲解知识点和技能点的同时,结合

学生学习计算机程序设计的心理和行为特点,以培养学生树立远大理想、爱党爱国爱民、践

行社会主义核心价值观、掌握科学的学习方法等为主线,将思政元素渗透到教材内容中,传

播新时代教育理念和学习理念,实现思想政治教育和专业知识技能教育的有机融合。

在修订过程中,我们继续秉承为课程服务的理念,基于企业实际应用场景,展现行业新

业态、新水平、新技术,进一步优化课堂案例、“习题与上机实践”“拓展提高”等部分内容及代

码,更有针对性地满足差异化教学,促进学生全面成长。

修订后的教材从JavaWeb应用开发技术的原理出发,详细地介绍了进行 Web应用开

发所需的基础知识和基本技能。 全书以JSP基本技术为中心,结合开发实例对各知识点和

技能点进行讲解,涵盖了JSP运行环境搭建、JSP语法、JSP内置对象、JavaBean及其应用、

Web前端脚本技术、Servlet技术、JSP数据库操作、JavaWeb安全应用等内容,最后部分为

课程设计实例,帮助学生巩固所学的知识和技能。 本书所涉及的HTML程序代码均采用了

HTML5标准。

本书由南京交通职业技术学院戎戟担任主编,国电南瑞科技股份有限公司朱康高级工

程师担任副主编,南京信息职业技术学院人工智能学院杨和稳和南京长江第二大桥有限责

任公司指挥调度中心信息中心王俊杰高级工程师担任主审。

由于编者水平有限,书中难免存在疏漏之处,敬请广大读者批评指正。

编 者
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JavaWeb是指用Java标准(以JavaEE为主体)进行 Web应用开发的技术路线的总

和。JSP是JavaEE中最为基础的也是最具有代表性的 Web开发技术标准。 近20年来,许

多对安全性要求非常高的 Web应用系统(如网上银行)均采用了JSP技术进行开发。 在

Windows操作系统中用JSP技术开发的 Web应用可以很容易地被移植到其他流行的操作

系统中。JSP技术是学习JavaWeb应用开发的入门技术,初学者在掌握JSP技术之后,可

进阶学习JavaEE体系中后续的高级技术,如SSH框架等。

本书以JSP基本技术为中心,详细地介绍了进行JavaWeb应用开发所需的基础知识和

基本技能,涵盖了JSP运行环境搭建、JSP语法、JSP内置对象、JavaBean及其应用、Web前

端脚本技术、Servlet技术、JSP数据库操作等内容,最后部分为课程设计实例,帮助读者巩固

所学的知识和技能。

本书共分8个模块,主要内容及学时分配见下表。

内  容 学  时

模块1 JavaWeb应用开发概述 4

模块2 JSP语法 8

模块3 JSP内置对象 12

模块4 JavaBean及其应用 12

模块5 Web前端脚本技术 8

模块6 Servlet技术 12

模块7 JSP数据库操作 12

模块8 课程设计实例 12

合计 80

本书面向初学者,对学习内容按模块化方式编排,从分析基础的实例入手设计学习内

容,从模块2开始,在每个模块的开头安排“回顾和思考”,总结上一个模块所学的知识,引出

学习本模块将面临的问题。 所选取的实例和部分习题及上机实践强调了“功能不断完善”的
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理念,引导学生熟悉“解决了问题,又发现新问题,再解决问题”的思维模式,培养学生养成良

好的学习习惯。

本书由戎戟主编。 由于编者水平有限,书中的疏漏之处在所难免,敬请广大读者批评

指正。

编 者
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1
JavaWeb应用开发基础

·了解 Web应用、Web应用开发、动态网页及B/S结构等 Web基础知识。

·了解JSP的执行流程和技术优点。

·掌握 Web应用开发的流程和简单JSP程序的编写与运行方法。

·能够在集成开发环境(integrateddevelopmentenvironment,IDE)中配置JRE。

·能够在EclipseIDE中配置并运行JSP引擎Tomcat。

·能够在EclipseIDE中创建并部署JavaWeb项目。

·能够在EclipseIDE中编写简单JSP程序并运行JSP程序。

·树立产业报国远大理想,熟悉并热爱未来的行业和工作。

1.1 Web基础知识

Web是存储在Internet上数量巨大的文档的集合,它是一种基于超文本和 HTTP的、

全球性的、动态交互的、跨平台的分布式图文声像信息系统。Web同时也是一种建立在

Internet上的网络服务,为浏览者在Internet上查找和浏览信息提供了图形化的、易于访问
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的直观界面,其中的文档及超级链接将Internet上的信息节点组织成一个互为关联的网状

结构。

1.1.1 Web应用及其开发 

  Web应用可以是一个构建并运行在 Web上的完整网站,也可以仅仅是某个运行在

Web上的应用程序。它是由一些 Web网页和用来完成某些特定任务的相关资源整合在一

起而形成的一个数据集合,通过服务器、客户端及网络等实现自身的功能。

Web应用可采用不同的技术来构建,每种技术皆有其优劣势。当今的 Web应用在其开

发线路上主要包含两部分内容:Web前端开发和 Web后端开发。

Web前端开发主要进行网站开发、优化和完善,包括 Web页面的结构、Web的外观视

觉表现及 Web层面的交互实现等工作。Web前端开发在知识体系运用和开发方式上,涵盖

了许多传统的网站后台开发内容,不再局限于传统的以网页制作为主的网站前台开发。

Web前端开发技术主要有HTML、CSS、JavaScript、DOM、JSON、JQuery、Ajax、VUE等。

Web后端开发主要进行与数据库交互作用所对应的业务逻辑设计,需要考虑功能的实

现、数据的存取、平台的稳定性与性能等。Web后端开发技术主要有JavaEE、.NET、PHP
等。当然,Web后端开发还涉及数据库管理系统、Web应用服务器、设计模式等方面知识和

技能的运用。

与过去在 Web应用开发中所使用的“前台”和“后台”概念相比,今天的“前端”和“后端”

的划分则对技术准则进行了广泛的延伸及综合。随着大数据、云计算及人工智能化时代的

逐步深入,如智能手机移动终端应用的大规模普及,今天的 Web应用开发从宏观到微观,从

内涵到外延,都与传统的 Web应用开发大不相同了。

Java是当今世界流行的编程语言和标准之一,它被广泛应用于各种领域,如大数据、人

工智能、云计算、智能家居、物联网等。随着科技的不断进步和社会的不断发展,Java也面临

着新的机遇和挑战。Web开发一直是Java的传统领地,未来Java在 Web开发方面将继续

发挥重要作用,包括 Hibernate、Spring、SpringMVC、MyBatis、Struts等框架的不断完善和

新功能的开发,Java在 Web开发方面的应用前景广阔。因此,从事JavaWeb方面的应用开

发与研究工作是一项积极且具有挑战性的选择。

1.1.2 动态网页 

  在Internet发展初期,Web应用只是一个静态网站。“静态”是指网站的所有网页内容

都基于静态的HTML页面,网站内容的修改只能通过修改静态的HTML页面来实现,Web
网站仅显示静态信息,而不能与用户产生互动。

随着商业需求的不断增长和Internet技术的不断发展,出现了用动态网页技术开发的

动态网站。动态网页是指在服务器端运行的程序或网页,它显示的内容随时间、物理访问位

置、用户及用户需求的改变而改变。例如,当我们作为普通用户登录某论坛网站时,只能看
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到帖子的浏览页面;而作为管理员登录时,同样的页面还会出现“添加”“删除”“修改”等操作

提示。此外,在不同的时间登录论坛,看到的帖子列表也是不同的。

动态网页的主要特点如下。

(1)交互性。网页会根据用户的要求和选择而动态改变和响应。例如,用户在网页中填

写表单信息并提交,服务器将所提交信息处理后自动存储到后台数据库中,并转至相应的提

示页面。采用动态网页技术构建的网站可以实现更多与用户的交互功能,如用户注册、用户

登录、信息查询、用户管理和在线操作等。

(2)自动更新。与静态网页修改后需重新上传以覆盖原先的页面相比,动态网页无需手

动操作,便会自动生成更新的页面,大大节省了工作量。

(3)随机性。不同的人在不同的时间或不同的物理访问位置访问同一网址时会产生不

同的页面效果。

当今的网站根据其功能需求和内容的多寡,往往采用“动静结合”的原则开发实现。在

同一个网站上,动态网页内容和静态网页内容同时存在是很常见的事情。

动态网页的设计需要使用到服务器端脚本技术,如Java服务器页面(Javaserverpages,

JSP)技术。本书将以JSP技术为核心,引导读者进行动态网站开发。使用动态网页技术开

发的网站实际上是浏览器/服务器(B/S)结构的一种体现。因此,要想熟练掌握动态网页的

开发技术,首先需要了解B/S结构的一些知识,这样才能更好地使用JSP技术开发动态

网页。

1.1.3 B/S结构 

  动态网页等 Web应用普遍采用分布式计算模式构建,使用该模式进行 Web应用开发

时,往往需要编写大量的程序。这些程序被部署在不同的计算机上,在 Web应用中承担着

不同的职责。例如,有的程序显示用户界面,有的程序进行逻辑运算,有的程序则进行后台

数据处理。相应的 Web应用在体系上分为多层结构,其中最典型的是浏览器/服务器/数据

库(browser/server/database,B/S/D)三层结构,如图1-1所示。

图1-1 B/S/D三层结构

第1层为浏览器。浏览器接收用户输入的数据,提交并发送至 Web服务器;还会接收

Web服务器返回的数据处理结果并显示。

第2层为 Web服务器(安装了提供 Web服务的应用程序及管理应用程序的计算机)。

运行在 Web服务器上的应用程序接收并处理用户数据,根据流程需要在数据库中进行数据

比对和处理。最后 Web服务器综合各项数据处理结果,生成动态页面,通过浏览器呈现给

用户。

第3层为数据库服务器。数据库服务器储存海量的用户信息,并提供数据处理和事务
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处理功能。

对于一些规模不是很大的动态网页等 Web应用,会把 Web服务器和数据库服务器安

排在同一台计算机上。在这种情况下,第2层和第3层就合并为同一层,统称为服务器端,

也就形成了浏览器/服务器结构,即B/S结构。在B/S结构的 Web应用中,浏览器端与服务

器端采用请求/响应模式进行交互。

随着Internet技术的不断深入,作为客户机/服务器(client/server,C/S)结构的一种改

进,B/S结构使得 Web应用的维护和升级更为简单,用户访问范围更广,信息资源共享程度

更高。

Internet是20世纪人类最伟大的发明之一。我国自1994年接入国际互联网以来,正确

处理安全和发展、开放和自主、管理和服务的关系,从最初的电子邮件、新闻网站,到如今的

社交媒体、电商平台,推动互联网发展取得世界瞩目的成就,初步形成了具有鲜明特色的中

国互联网体系。通过推进“互联网+”行动计划、实施大数据发展战略等措施,中国已经成功

构建起数字基础设施体系,为数字中国建设奠定了坚实基础。

当今世界正处在互联网飞速发展的历史进程中,中国互联网体系顺应世界互联网发展

潮流,植根于中国发展实践,既有突出的开放性和包容性,又有鲜明的自主性和创新性。面

向未来,中国互联网体系将不断丰富和发展,日益彰显出自身的特色和优势,在推动中国社

会主义现代化建设和中华民族伟大复兴的进程中发挥更加重要的作用,为东西方思想文化

的交流融合乃至人类文明发展作出新的重大贡献。

1.1.4 Web开发技术之一———JSP简介 

  JSP技术是Java企业版(Javaenterpriseedition,JavaEE)中的一个关键技术,是用Java
标准开发服务器端 Web应用的主要技术。打开JSP文件,可以看到JSP文档是在 HTML
代码中嵌入Java脚本(添加了JSP标记的Java代码)编写而成的。JSP文件以.jsp为扩

展名。

通过浏览器访问一个JSP页面时,Web服务器根据该请求加载被请求的JSP文件;然

后 Web服务器中的JSP引擎(用来统一管理和运行JavaWeb应用程序的软件,也可称为

JSP容器,如 Tomcat、JRun、Resin等)将被加载的JSP文件转译成Servlet源文件(以

.java为扩展名),JSP引擎再将生成的Servlet源文件编译成Java类文件(以.class为扩展

名);最后,Web服务器执行该Java类文件,并将结果在浏览器显示,如图1-2所示。

作为Servlet(JSP诞生之前的一种服务器端动态页面Java编写技术)的一种改进,JSP
页面负责将服务器端运算结果与 HTML等静态内容结合后发送到浏览器,Servlet和

JavaBean(一种JSP组件)则负责较为复杂的业务逻辑计算,生成相应的动态运算结果。

JSP技术的特点如下。

(1)JSP分离了服务器端程序中的静态内容和动态内容。

(2)JSP提供组件(如JavaBean)、标准标签、自定义标签等可一次生成重复利用的实现
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方式,大大提高了程序开发效率。

(3)JSP页面在被第一次请求时进行编译,如果在后续的请求中该页面没有改动,服务

器可直接调用相应的已被编译好的代码,大大提高了访问速度。

(4)JSP沿用了Java强大的应用程序编程接口(applicationprogramminginterface,

API)功能,只要服务器支持JSP,就可以运行用JSP开发的 Web应用,体现了JSP的跨平台

优点。

图1-2 JSP的执行流程

1.2 创建第一个 Web项目

使用JSP进行 Web应用开发,需要准备以下开发工具:JDK、Web服务器、JSP集成开

发环境、Web浏览器及 Web数据库等。

1.2.1 JSP运行环境搭建 

1.JDK

进行程序开发首先要安装JDK。JDK可到Java官方网站(https://www.oracle.com/

java/)中进行下载,如图1-3所示,然后运行安装即可。本书建议采用JDK1.8及以上版本。
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图1-3 Java官方网站

2.Web服务器

本书选择Tomcat作为 Web服务器中的JSP引擎。Tomcat可到ApacheTomcat官方

网站(http://tomcat.apache.org)中进行下载,如图1-4所示,然后解压至某固定文件夹即

可(也可下载相应的安装程序安装)。本书采用ApacheTomcat9.0.63版本。

图1-4 ApacheTomcat官方网站
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3.Web浏览器

浏览器是用户访问 Web应用的工具,JSP开发的 Web应用程序对浏览器没有特殊要

求。本书采用64位 MicrosoftEdge作为 Web浏览器。

4.Web数据库

JSP开发的 Web应用程序通过Java数据库互连(Javadatabaseconnectivity,JDBC)驱

动可访问多种数据库管理系统。在实验室学习环境下,数据存取规模不大,故本书选用

MySQL数据库管理系统提供 Web数据库服务。MySQL数据库管理系统可到 MySQL官

方网站(https://www.mysql.com)中进行下载,如图1-5所示。本书采用 MySQL5.5.38
版本。

图1-5 MySQL官方网站

1.2.2 JSP集成开发环境Eclipse 

  EclipseIDE是一个用于JavaWeb应用开发的成熟的企业级平台。EclipseIDE可到

Eclipse官方网站(https://www.eclipse.org)中进行下载,如图1-6所示。本书采用Eclipse

IDEforEnterpriseJavaandWebDevelopers-2022-09版本。
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图1-6 Eclipse官方网站

  在 Windows操作系统中,单击桌面的“开始”菜单按钮,执行“所有程序”→“Eclipse”命

令,在展开项中选择“EclipseIDEforEnterpriseJavaandWebDevelopers-2022-09”选项,启

动Eclipse2022,会出现图1-7所示的Eclipse2022主窗口。

图1-7 Eclipse2022主窗口

每次启动Eclipse时,都会提示选择工作区,选好工作区后(如果以后不打算更改,可选

中下方的复选框)单击“Launch”按钮即可,如图1-8所示。
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图1-8 选择Eclipse工作区

1.2.3 在Eclipse2022下用JSP开发 Web项目 

  在所有需要下载、安装的软件准备好之后,就可以在Eclipse2022上创建 Web项目,编

写JSP页面了。但是在创建 Web项目前后,还需要按以下步骤做一些整合工作,以便所创

建的 Web项目能成功运行。

1.配置JRE

运行Java程序时需要JRE的支持。可根据需要手动配置已下载的较高版本的JRE。

(1)启动Eclipse2022,执行“Window”→“Preferences”命令,在弹出的“Preferences”对

话框中展开左侧目录树中的“Java”选项,从中选择“InstalledJREs”选项,如图1-9所示。

图1-9 已安装的JRE
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(2)Eclipse2022内嵌的JRE版本为1.8.0,如果需要更换为更高版本的JRE,可单击

“Add...”按钮,在弹出的“AddJRE”对话框中选择“StandardVM”选项,如图1-10所示。

图1-10 JRE类型选择

(3)单击“Next”按钮,打开“JREDefinition”界面,如图1-11所示。

图1-11 JRE定义界面
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(4)单击“Directory...”按钮,在弹出的“选择文件夹”对话框中选择已安装的较高版本

的JDK,单击“选择文件夹”按钮,如图1-12所示。

图1-12 选择已安装的较高版本的JDK

(5)返回到添加好路径的“JREDefinition”对话框,单击“Finish”按钮,完成JRE配置。

注意:不要忘了在“InstalledJREs”选项组中选中新添加的JRE,使配置生效。

视频

Tomcat配置

2.配置Tomcat

(1)在Eclipse2022主窗口中执行“Window”→“Preferences”命令,弹

出“Preferences”对 话 框,展 开 左 侧 目 录 树 中 的“Server”选 项,选 择

“RuntimeEnvironments”选项,如图1-13所示。

图1-13 添加服务器运行环境
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(2)在右侧“ServerRuntimeEnvironment”界面中单 击“Add...”按 钮,弹 出“New

ServerRuntimeEnvironment”对话框,展开“Apache”选项,选择“ApacheTomcatv9.0”选

项,再选中下方的“Createanewlocalserver”复选框,如图1-14所示。

图1-14 定义新服务器运行环境

(3)单击“Next”按钮,打开“TomcatServer”界面,在“Tomcatinstallationdirectory”文

本框中输入Tomcat9.0所在的目录位置,单击“Finish”按钮,如图1-15所示。

图1-15 指定Tomcat安装目录
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(4)返回“Preferences”对话框,可以看到所添加的Tomcat9.0服务器,单击“Applyand

Close”按钮,结束 Tomcat配置。在 Eclipse2022主窗口的“PackageExplorer”视图的

“Servers”目录下出现了所添加的在本地的Tomcat9.0服务器,如图1-16所示。

图1-16 添加的Tomcat9.0服务器

(5)双 击“Servers”目 录 下 的“Tomcatv9.0Serveratlocalhost-config”选 项,打 开

Tomcat服务器本地概览“Overview”文件,“ServerLocations”选择“UseTomcatinstallation
(takescontrolofTomcatinstallation)”选项,修改“Deploypath”选项,在文本框中输入

Tomcat服务器下webapps目录所在的路径,并保存,如图1-17所示。

图1-17 Tomcat服务器配置概览
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3.启动Tomcat

启动Tomcat的方式有以下两种。

(1)在Eclipse2022主窗口快捷图标栏单击“RunTomcatv9.0Serveratlocalhost”图标

右侧的下拉按钮,在弹出的下拉菜单中执行“Tomcatv9.0Serveratlocalhost”命令,启动

Tomcat,如图1-18所示。

图1-18 启动Tomcat的方式1

(2)在Eclipse2022主窗口的“Servers”目录中,执行“Tomcatv9.0Serveratlocalhost-

config”命令,右击,在弹出的快捷菜单中执行“Start”命令,启动Tomcat,如图1-19所示。

图1-19 启动Tomcat的方式2
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上述命令被执行后,会在控制台输出Tomcat的启动信息,如图1-20所示。

图1-20 Tomcat的启动信息

打开浏览器,在地址栏输入“http://localhost:8080”,打开相应版本Tomcat的主页面,

表示Tomcat已被成功安装并启动,如图1-21所示。

图1-21 验证Tomcat成功安装与启动

4.创建 Web项目

(1)在 Eclipse2022主窗口中执行“File”→“New”→“Project...”命令,弹出“New
Project”对话框,展开“Web”选项,从中选择“DynamicWebProject”选项,创建一个动态
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Web项目,如图1-22所示。

视频

创建 Web项目

图1-22 选择“DynamicWebProject”选项

(2)单击“Next”按钮,打开“NewDynamicWebProject”界面,在“Projectname”文本框

中输入项目名称“myPro”,选择下方“Targetruntime”列表项的值为“ApacheTomcatv9.0”,

“Dynamicwebmoduleversion”列表项的值为“4.0”,“Configuration”列表项的值为“Default

ConfigurationforApacheTomcatv9.0”,其余选项保持默认设置,创建基于Java的独立

Web应用,如图1-23所示。

图1-23 “DynamicWebProject”界面
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(3)单击“Next”按钮,打开“Java”界面,保持默认值,配置项目以构建Java应用,如

图1-24所示。

图1-24 “Java”界面

(4)再 次 单 击 “Next”按 钮,打 开 “Web Module”界 面,选 中 “Generateweb.xml

deploymentdescriptor”复选框,其余保持默认值,配置 Web模块设置,如图1-25所示。

图1-25 “WebModule”界面
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(5)单击“Finish”按钮,此时会弹出“OpenAssociatedPerspective?”对话框,提示“Open

theJavaEEperspective?”,可选中左下方的复选框,记住用户的决定,如图1-26所示。单击

“OpenPerspective”按钮,完成 Web项目创建。

图1-26 打开JavaEE透视图

5.设计 Web项目的目录结构

Web项目要求按特定的目录结构组织文件,当在Eclipse2022中创建好一个新的 Web
项目后,便可以在Eclipse2022的“PackageExplorer”视图中看到该 Web项目的目录结构,

它是由Eclipse2022自动生成的。

下面来了解一下 Web项目目录及文件的用途。
(1)DeploymentDescriptor目录:项目的部署描述符,包括上下文参数、错误页面、过滤

器映射(filtermapping)、过滤器(filter)、监听器、引用、Servlet映射、Servlet等项,以及子目

录欢迎页面下各种类型的欢迎页面在web.xml文件中的配置信息。

注意:在Eclipse2022中创建 Web项目,不会自动生成欢迎页面。欢迎页面需要用户自

行创建。
(2)JAX-WSWebServices目录:即JavaAPIforXMLWebServices,包括服务器端点

接口和 Web服务两个子目录。
(3)JavaResources目录:包括两个子目录,分别存放项目所需的库文件(Libraries)和从

src目录中分离出来以便于开发管理的项目源文件。
(4)build目录:项目的默认输出文件夹,存放经自动编译后生成的Java字节码文件。
(5)src目录:Java构建路径上的源文件夹,包括 Web项目的顶层目录webapp。webapp

由以下部分组成。

①META-INF目录:系统自动生成,存放系统描述信息。

②WEB-INF目录:无法被用户访问。它由以下两部分组成。
·lib目录:包含 Web项目所依赖的.jar或者.zip文件。
·web.xml文件:Web项目的初始化配置文件,不要将其删除或随意修改。

③JSP文件:Web项目中所创建的JSP文件默认存放在此目录下,也可以在此目录下创

建一些文件夹,根据开发需要把不同的JSP文件放在对应的文件夹中。

④静态文件:包括所有的HTML文件、CSS文件、图文声像文件等。静态文件可按功能

以文件夹形式分类存放。

6.编写 Web项目的代码

(1)展开myPro项目的src目录,在其子目录webapp下创建一个文件夹。右击“webapp”
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目录,在弹出的快捷菜单中执行“New”→“Folder”命令,如图1-27所示。

图1-27 创建webapp目录下的文件夹

(2)在弹出的“NewFolder”对话框中输入文件夹名称“ch1”,单击“Finish”按钮,如图1-28
所示。

图1-28 输入文件夹名称
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(3)创建一个JSP文件。在创建JSP文件之前,可设置JSP文件的默认编码。在

Eclipse2022主窗口中执行“Window”→“Preferences”命令,弹出“Preferences”对话框,展开

左侧目录树中的“Web”选项,选择“JSPFiles”选项,在窗口右侧“Encoding”下拉列表中选择

“ISO10646/Unicode(UTF-8)”,如图1-29所示。单击“ApplyandClose”按钮,完成JSP文

件的默认编码设置。

图1-29 设置JSP文件的默认编码

(4)右击“ch1”选项,在弹出的快捷菜单中执行“New”→“JSPFile”命令,创建一个新的

JSP文件,如图1-30所示。

图1-30 创建JSP文件



21   

(5)在弹出的对话框中输入文件名称“NewFile.jsp”,存放在“myPro/src/main/webapp/

ch1”目录下,如图1-31所示。

图1-31 输入JSP文件名称

(6)单击“Next”按钮,打开“SelectJSPTemplate”界面,选择一个模板作为JSP页面的

初始内容,这里选择“NewJSPFile(html5)”模板,如图1-32所示。

图1-32 选择JSP模板

(7)单击“Finish”按钮,完成JSP文件的创建。NewFile.jsp文件在Eclipse2022主窗口

的编辑区同时被打开,在<body></body>标签之间输入文本“ThisismyJSPpage.”,保
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存,如图1-33所示。

图1-33 JSP文件的编辑区

注意:所创建的JSP文件必须放在src根目录的webapp子目录下或webapp子目录下

自行创建的各级子目录下,否则无法被访问。

视频

部署和运行 Web项目

7.部署 Web项目

部署 Web项目的方式有以下两种。

(1)在Eclipse2022主窗口的“PackageExplorer”视图中右击“myPro”

项目,在弹出的快捷菜单中执行“RunAs”→“RunonServer”命令,如

图1-34所示。

图1-34 部署 Web项目方式1
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在弹出的“RunonServer”对话框中选中“Chooseanexistingserver”选项,在“Server”选

项区中展开“localhost”,选择“Tomcatv9.0Serveratlocalhost”选项,如图1-35所示。

图1-35 选择在其上运行项目的服务器

单击“Next”按钮,打开“AddandRemove”界面,“Configured”文本框中出现所配置的

Web项目“myPro”,如图1-36所示。

图1-36 向服务器添加或移除的项目资源
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单击“Finish”按钮,如果服务器此时处于已启动状态,会弹出“Server”对话框,提示服务

器可能需要重启,选中“Restartserver”选项,如图1-37所示。单击“OK”按钮关闭该对话

框,完成 Web项目部署。

图1-37 重启服务器提示

(2)在Eclipse2022主窗口的“Servers”目录中右击“Tomcatv9.0Serveratlocalhost-

config”选项,在弹出的快捷菜单中执行“AddandRemove...”命令,如图1-38所示。

图1-38 部署 Web项目方式2

在弹出的“AddandRemove”对话框的“Available”文本框中出现待配置的 Web项目

“myPro”,如图1-39所示。
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图1-39 待向服务器添加的项目资源

  选中“myPro”选项,单击“Add”按钮,在“Configured”文本框中出现所配置的 Web项目

“myPro”,可选中“Ifserverisstarted,publishchangesimmediately”复选框,使被部署的项

目能得到及时更新,如图1-40所示。单击“Finish”按钮,完成 Web项目部署。

图1-40 已完成部署的项目资源
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注意:Web项目部署完成,启动 Tomcat后才会在 Tomcat的下一级目录 webapps及

work中出现所部署的 Web项目。

8.运行 Web项目

打开MicrosoftEdge浏览器,在URL栏输入http://localhost:8080/myPro/ch1/NewFile.

jsp,并按Enter键查看运行结果。在浏览器窗体的页面中显示“ThisismyJSPpage.”,表示

Web项目“myPro”中的“NewFile.jsp”文件已经正确运行,如图1-41所示。

图1-41 NewFile.jsp页面

注意:URL中“myPro”是网站对外发布的虚拟上下文路径,它对应的实际路径是 Web应

用的文件根目录,即“webapp”文件夹。URL中 Web项目资源的访问路径是区分大小写的。

1.3 小  结

Web是存储在Internet上数量巨大的文档的集合。Web应用是由一些 Web网页和用

来完成某些特定任务的相关资源组合在一起而形成的一个数据集合,通过服务器、客户端及

网络等提供服务功能。Web应用开发包含 Web前端开发和 Web后端开发。采用动态网页

技术开发的网站可以实现更强的交互性和智能化功能。B/S结构是C/S结构的一种改进,

使得 Web应用的维护和升级更为简单,用户访问范围更广,信息资源共享程度更高。JSP
技术是用Java标准开发服务器端 Web应用的主流技术。使用JSP进行 Web应用开发需要

JDK、Web服务器、JSP集成开发环境、Web浏览器及 Web数据库等开发工具。在Eclipse
2022下用JSP开发 Web项目的步骤为:配置JRE→配置Tomcat→创建 Web项目→设计

Web项目的目录结构→编写 Web项目的代码→部署 Web项目→启动Tomcat→运行 Web
项目。
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1.4 习题与上机实践

一、单项选择题

1.JSP文件的扩展名为(  )。

A..jsp B..java C..js D..class

2.以下不能当作 Web应用服务器使用的是(  )。

A.Tomcat B.JRun C.Resin D.Eclipse

3.用JSP标准进行JavaWeb开发需要(  )的支持。

A.Java标准版 B.Java企业版 C.Java简化版 D.Java移动版

4.Web项目的初始化配置文件是(  )。

A.index.jsp B.index.html C.web.xml D.server.xml
二、判断题

1.有动画呈现的网页就是动态网页。 (  )

2.目前,B/S构型的 Web应用已经完全取代了C/S构型的 Web应用。 (  )

3.Web应用只有被部署到 Web服务器上之后才能正确运行。 (  )

4.Web项目资源的URL不区分大小写。 (  )

三、实践题

1.用百度搜索 Web、Web应用、Web应用开发、动态网页、B/S、JSP等关键词,收集相关

信息进行学习和分析。

2.在EclipseIDE中编写一个JSP页面,输出“这是我的第一个JSP页面”。

1.5 拓 展 提 高

1.回顾并总结在EclipseIDE中用JSP开发 Web项目的软件安装及配置全过程,并在

计算机上进行实践。

2.index.jsp页面代表 Web项目生成的网站主页或者称为欢迎页面。如何在浏览器中

访问该页面? 如何在 Web项目中更改原先设置的欢迎页面?


